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INTRODUCTION
This User Manual applies to the AutoGRAPH.NET Dispatch Software version 2015.3.3 (release 90), 
developed by TechnoKom Ltd.
The User Manual is intended for standard users who are aware of the operating principles of vehicle 
and personal tracking systems as a whole. For information on the software configuration and 
administration see the User manual for advanced users. 

AutoGRAPH.NET is a multifunctional dispatch software based on multiple modules which can 
be connected together to make single system intended to monitor asset location in real-time, to 
monitor history of movements and state of asset’s parameters,  generate reports,  notify the user 
about different events, etc. 

GLOSSARY
ASSET is a vehicle or a person equipped with a tracking device.  

GEOFENCE  is any virtual enclosed area on a map which is used to generate a notification 
or trigger a preset event when an asset enters or exits this area.

CP –  control point. The control point is a circular geofence.

PC – personal computer. 
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SYSTEM REQUIREMENTS 

Parameters Minimum system requirements Recommended system requirements

Operating system Microsoft Windows XP SP3 Microsoft Windows 7

Processor Intel Core i3 2 GHz Intel Core i5 2 GHz and higher

RAM 2 GB 4 GB

Hard disk space 150–200MB free disk space (not including the space for data)

Screen resolution 1680х1050 dpi 1920х1080 dpi

Internet connection required to load internet maps and download data from dataserver.

Software requirements  .NET Framework 4.0. 

Fig.1. Running installation. Fig.2. Selecting installation directory.

SOFTWARE INSTALLATION 
Before installation, be sure that your PC meets the system requirements. 

To install the software, download the installation file from the official web-site or official forum (if  
beta version of software is required) of  Technokom. Then:

1. Run the AutoGRAPH.NET_Setup.exe file and select the language to launch the installation wizard. 
You will be prompted to accept the AutoGRAPH.NET License Agreement. Read the agreement 
carefully. If you agree with the license terms, accept the agreement and go to the next step of 
installation, otherwise cancel the installation procedure.

2. Browse to the installation directory.
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GETTING STARTED
LOGGING ON
Before starting, a user must log into the system.

When running the software, the “Log on Server” screen requires the user to enter valid user name 
and password to gain access to the data and the software functions.  Logging onto the server also 
provides access to the user schemes and files on server, which can be downloaded to a local folder, 
if necessary. 

Contact your dealer to obtain personal login and password to access AutoGRAPH.NET.

Fig.3. Selecting additional modules.

3. Select which components to install. Demo configuration is a pre-configured scheme intended to 
try new features of the software. Demo data is a sample data for the demo configuration.

4.  Continue installation.  Please wait until it is completely finished.  

5. After finishing, you will be prompted to run the AutoGRAPH.NET Software. 

Fig.4. Completing installation. 

Fig.5. Logging on.

The «Remember Me» option will save the current user credentials so that 
they don’t have to be entered every time the software is launched.
To get familiar with the basic features  of  the software  you can use a demo 
version with demo configuration and data. To log in to the demo version 
use “demo” login and “demo” password.  
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LOADING SCHEMES
1.	 Run the AutoGRAPH.NET software on your PC.
2.	The software will launch with the scheme that was used during the previous session. When 
running the software for the first time after installation, it will launch the demonstration scheme (if 
installed) by default.
3.	If no scheme is found to launch (scheme has been deleted, moved or has not been installed), 
the software will launch a blank scheme template. In this case, it is recommended to load the 
required scheme manually. To open the scheme, follow Main menu - Scheme Menu - Open and select 
the required scheme in the drop-down list. This list contains schemes stored in \ProgramData\
AutoGRAPH Shell\Schemes directory on system hard drive.

4.	Available schemes can be downloaded from the server.  To do this:
•	 follow Main menu - Scheme Menu - Load from server to run “Load files from server” menu (Fig.7). 

This menu is intended to downloaded schemes,  maps, modules and report templates available 
to the user. 

•	 specify server settings and enter valid user registration data. 
•	 press the “Connect” button to connect to the server. If valid registration data has been entered, the 

list of available files will be downloaded.  
•	 go to the “Scheme” tab and select the required schemes by checking boxes. 
•	 go to other tabs and select necessary files to download.  
•	 press the OK button to start downloading. Selected schemes will be downloaded into \

ProgramData\AutoGRAPH Shell\Schemes folder and become available to select in the “Open” menu 
(Fig.6). After downloading, the “Load files from server” menu will be automatically closed.

1
2

3

Fig.6. Opening the scheme.

Fig.7. Load files from server.
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OVERVIEW
After successful login, the software functions become available. Listed below is a short description 
of general menus and functions of the AutoGRAPH.NET. The interface can vary depending on the 
scheme and desktop settings. 

Fig.8. Overview.

Title consists of  a software version and description of the open scheme. 

Main menu. General operations of the software are available in main menu. Some 
operations are available via keyboard shortcuts. 

1
2

4

3

5

Language. Clicking the icon displays the list of available languages. After selecting the 
language, the software will be restarted. 

1

2

3

4 Desktop. It is the working area of the application that displays the modules. The application 
has the default desktop (Desktop 1), however users can customize the desktop, if necessary. 
To set the default desktop, follow View Menu - Desktops - Desktop 1.

Status bar. The bar may be hidden when needed. To hide the bar uncheck the “Show status 
bar” box in “Panels Settings” of  the “Window” menu.

5
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The Navigation tool integrated in the software allows users 
to arrange windows freely. When moving a window the tool 
shows different window arrangement. 

Fig.9. Navigation tool. 
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Fig.10. Sample of track displayed on map.  

DATA VIEWING
This section covers description of procedures of data viewing, reporting and charts creation in 
AutoGRAPH.NET. 

To view data:
•	 select data to view in Device selector;
•	 select a trip in Trips selector, if sharing to trips is enabled;
•	 selected tracking data will be displayed on a map. 

Detailed information on sharing data to trips, viewing current position of assets and history of their 
movement is also given in the sections below. 

DATE / TIME SELECTION
By default the Device selector groups the data from each vehicle into separate files on a weekly 
basis (Fig.11). Each file is dated by week start date. When selecting any file, the user will review data 
for a whole week. 
The Device Selector enables data viewing fro a custom time period (Fig.12). 

To view data for a custom period:
•	 select  the Time span mode in “View” menu of the Device selector. 
•	 specify custom start and end values or select one of the preset intervals in Time span selector 

(Fig.13).
•	 data from the selected period will be displayed in AutoGRAPH.NET. 
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Fig.11. File view. Fig.12. Time span view.

Fig.13. Time span selector.

SHARING TRACK TO TRIPS
Trip selector divides data covered by selected interval into trips according to trip settings. Sharing 
track to trips enables data viewing and calculation of asset parameters for separate trips. 

Fig.14. Trip selector.
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Pressing the “Share trips“ button         shares the selected track to trips. A second press on the button 
disables the sharing. Each trip is displayed on a single row, which consists of information on the trip 
duration, vehicle distance per trip, maximum and average speeds per trip, etc.  Columns of the table 
are fully configurable.  The user can select default columns or a user-defined set. The “Fixed-column” 
button        allows display of user-defined  columns. A second press sets the default view. 
The weekend trips are highlighted in red in the Trip selector. Selecting trip displays vehicle track for 
this trip on a map.  
Total row consists of total parameters of vehicle  per selected time span.
Pressing the button       opens a drop-down menu in the Trip Selector. Functions of menu are 
described below:
Group trips - sorts the trip into groups and subgroups depending on the trip sharers.

Fig.15. Menu of Trip selector.

Group rows view - is used to configure the view of group 
titles when trips are grouped: short, normal or detailed.
Show sharer columns - displays columns with the sharers’ 
description.
Show total row - displays total parameters for all trips. Total 
row is displayed  in the bottom of the trip list.
Go to start entry - highlights the first entry of the selected 
trip in the Data viewer. You can go to the start entry by 
pressing Enter key.
Go to end entry - highlights the last entry of the selected trip 
in the Data viewer. You can go to the end entry by pressing 
Ctrl+Enter keys.
Copy selected rows - copies selected entries to the clipboard.
To Excel - exports the list of trips to an MS Excel file.
Print - prints the list of trips out.

VIEWING THE TRACK
Maps viewer allows the user to monitor vehicle position in real-time, as well as to view history of 
all vehicle movements. When selecting data and trip to view, the Map viewer displays vehicle track 
from selected file.  A special cursor shows vehicle position at the selected time. The user can select a 
point on the track to view. Double clicking on the track moves the cursor to the selected point and 
highlights the entries on Trip selector and Stages viewer which the selected point refers to. 

Viewing online data
To view the current position of a vehicle, select a vehicle or a group of vehicles to view in the Device 
selector. 
Mode of view of online data allows the user to select online data to view. To change this, press 
button   in the tool bar of Map viewer and select necessary mode in the drop-down list.
•	 Current group displays the online data of the selected group only. When selecting a device, online 

data of all vehicles of the Device selector will be displayed on map.



AutoGRAPH.NET • USER MANUAL12

TechnoKom © 2015

•	 Current group and inside displays online data of the selected group of vehicles and vehicles of the 
nested groups. When selecting a device, online data of all vehicles of the Device selector will be 
displayed on the map.

•	 All vehicles displays last known position of all vehicles. 

When viewing online data,  the Maps viewer shows the positions of vehicles out of the working area 
of the map with arrow. 

When selecting a vehicle to view,  the Values indicator displays online data: last known position of 
the vehicle, state of inputs,  outputs and sensors of on-board tracker, installed on this vehicle. 

Fig.16. Values indicator.

History of vehicle movement
To view history of vehicle movement:
•	 select data to view in the Device selector. 
•	 if the Time Span mode is enabled, specify period in the Time Span selector. 
•	 select a trip to view, if the track sharing to trips is enabled in the Trip selector.
•	 the Map viewer will show the track from the selected file,  if the File mode of view is enabled; or 

the track  in a specified period,  if the Time Span mode is enabled. 

The user can set parameters of the track displaying using buttons on the tool bar of the Maps viewer. 

Vehicle always center of map. If  the button is pressed, the vehicle cursor always 
will be in the center of the map when playing the track. For detailed information 
on track playing see “Playing the track” section.

Hide track. Press the button to hide the track. Second press displays the track 
again. 
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Pressing the stage icon on the track displays a hint with information on this stage.  
An index under the stage icon allows the user to find associated items in the Stages viewer. 

Playing the track
Using the Player integrated in the scheme, the user can a play selected track. When playing, the 
cursor moves along the track from the start track point to the end track point of the selected time 
period. Before playing, it is recommended to select playback speed and set another parameters of 
the Player.

Show track point.  Press the button to show points on the track. Clicking on a track 
point displays a hint with information about this point.

Show direction track.  Press the button to show direction of travel.

Segments track. Press the button to show stages on the track. In the button’s 
drop-down menu, user can optionally display or hide different stages on the track. 

Fig.17. Player.

Set zero
Sets the current track point as the zero point .

Go to zero
Goes to the zero point.

Skip parking
Skips times when vehicle is parked, when playing the track. 

Autorepeat 
Repeats the playback for selected time span.

Settings
Change playback settings in a drop-down menu.

Player  range - select data range to play, if the track is shared by trips:
•	 Whole calculated time span - to play the track per selected time period.
•	 Current trip time span only - to play only the track per selected trip. 
Multiple trip selectors - allows setup of playback, if several Trip selectors are installed in  the scheme. 
•	 Time spans overlap with alignment on start - data of different Trip selectors is played simultaneously 

and start points of those intervals are aligned.
•	 Single time span - all selected intervals are played one by one  in chronological  order. 
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Start
Goes to the start point of the selected time span. 

Rewind
Press and hold this button to rewind.

Play
Runs the player.

Fast forward
Press and hold this button to fast forward.

Finish
Goes to the end point of the selected time span.

Use player  buttons to play the track. 

When playing the track, the player displays duration of selected time period and date and time of 
the point, which is currently playing. 
Move the player slider to select section to play. 
When playing, vehicle cursor moves along the track, passing track points in chronological order. 
During playback the modules synchronised with the Player are highlighting entries (or stages) 
associated with the point which is currently playing.

SETTINGS OF THE MAP VIEWER
Loading the required map
The AutoGRAPH.NET Software supports internet, vector and raster maps. 
Maps viewer selects the most appropriate map from the list of available maps to display the track. If 
there is no suitable map in the list, the track will be displayed on a template of a geographical map, 
which is the cylindrical projection of an area occupied by the selected track. The segment of a map 
with the track can be filled partially. Maps can partially overlap each other or nest within each other. 
For example,  when the district map is overlapped by the more  detailed maps of its settlement. 

1 2 3 4 5 6 7 8 9

Fig.18. Tool bar of the Map viewer.

In the drop down list of available maps (Fig.18, i.1) on a tool bar of the Map viewer, the user can select 
the necessary map. The list contains all vector, raster, and  Internet maps added to the application. 
Advanced users can add new maps to this list. The list contains  the name and type of each map. If 
the vector or raster map has not been loaded in the Maps Viewer,  “Map type” field will display  “is not 
open”  message. Maps which are not open, aren’t used to display the track.  To open them manually, 
the user should  select these maps from the list. 
To view additional information about selected map, press the “Map information“ button (Fig.18, i.2). 
In the drop-down menu of the button, user can set parameters of internet maps. 
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Fig.19. Map settings.

Export current frame to - copies the current frame of a map to 
the clipboard  or saves it as an image file. 
Update traffic - updates the traffic information.
Load tile - enables loading of tiles via the Internet, using cache 
files or simultaneously from the cache files and via the Internet.  
Show additional layers - shows reference map layers. 
Shows traffic - shows traffic information. 
Refresh map - forces the Map viewer to refresh the map.  

In the map selection, there is an option to automatically select the most appropriate map for 
different levels of detail. To enable this function, press “On/Off selection  of maps on detail levels” 
(Fig.18, i.8) in the tool bar. A second press disables the auto-selection. In the context menu of this 
button, the user can select the types of the maps available for auto-selection. To change the level of 
detail, use the slider (Fig.18, i.9). 

There are vector maps on the server, which are available to download. To download, press the 
“Download map” button (Fig.18, i.4) on the tool bar and select maps in the menu.  

To add a map to the list of available maps, go to the common settings of the Map Viewer. By pressing 
the “ Settings” button on the tool bar (Fig.18, i.3). The user can add vector and raster maps and select 
internet map  in the menu. To add a vector or  raster maps, go to the “Raster & vector maps” tab 
(Fig.20). The AutoGRAPH.NET supports raster and vector map of the .mp and .agv formats. 

Fig.20. Raster & vector map settings.

To load a new map:
•	 press “Add map” button and select the 

required map. A new map will be added 
to the list on the “Raster & vector maps” 
tab;

•	 check the box beside the map to add it 
to the Maps viewer to view the track.

•	 check “Preload” box to allow the map 
loading when running the application. 
This option speeds up the map loading 
when selecting it in the Map Viewer. 

•	 specify the level of detail in the “Level of details” field. This option allows the user to specify map 
selection to view the track in auto-selection mode. 

•	 select the method of the identification of the map borders:
•	 by image -   to identify map borders by the edges of the map images.
•	 by data points - to identify the borders by the limiting reference coordinates.  It is recommended to use this method for raster maps. 
•	 by borders - to identify borders according to the reference file.  Use of this method prevents the track appearing on blank, informational, 

or branded areas of the map. The border file can be specified manually in Mapborder (OziExplorer plug-in) for raster maps or using the 
relevant polygon type for vector maps.
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Measuring distances on a map 
This function allows measuring of distances between two or more points on a map. To enable  
measuring mode, press the “Measure distances on a map” button (Fig.18, i.5) on the tool bar. Left 
click selects points on a map to measure distance between them. The total distance from the first 
point to the last one is indicated on the tool bar on the right of the “Measure distances on a map” 
button. A second press on the button disables the measuring mode.

Routing
The AutoGRAPH.NET Software supports automatic routing between two selected points on a map. 
To calculate a route:
•	 press  “Route” button (Fig.18, i.6) on the tool bar of the Map viewer. 
•	 select a routing method in the drop-down list. There are two routing methods intended for 

internet maps (Google and Progorod) and one for routing on vector maps (Vector routing). Vector 
routing is available only for vector maps with the graph file.  

•	 left click to select a start point on a map. 
•	 then select midpoints of the route. When selecting points, the software automatically calculates 

the route between them. The route distance is indicated on the right of the “Route” button on the 
tool bar.  

•	 to add a midpoint between two points of the route, move the route section connecting these 
points, to the required area on the map. Use the left click to move the section.  

To delete a map from the list, select the map and press the “Delete map” button. 

Fig.21. Internet map settings.

To add internet maps go to the “Internet 
maps” tab. The list on this tab consists 
of all internet maps supported with the 
AutoGRAPH.NET.
To add a map in the Maps viewer, 
check the box  of the required map. 
The selected map becomes available to 
display the track in the Maps viewer. 

Since the Internet map providers (vendors) change and revise the terms of their license agreements from time 
to time,responsibility for using Internet maps shall be borne by the software user at all times. If you have 
discovered that the current edition of the license agreement of Internet map provider forbids the use of this 
map, disable this Internet map and do not use it.

iNOTE
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Searching address
The AutoGRAPH.NET supports operation with address databases and provides searching of 
necessary address on an internet map. 
To find an address:
•	 enable address searching by pressing the “Address” button (Fig.18, i.7) on the tool bar. 
•	 select required address database in a drop-down menu of the button.
•	 enter an address in the field on the right of the “Address” button.
•	 press Enter to start searching. 
•	 if the address has been found, it will be shown on the map.

Options described below allows the user to setup the map display.

Fig.22. Route settings. 

•	 after setting all points, enable the context menu by right clicking on the route. In this menu, the 
user can set parameters of the route and convert it to a geofence:

Grid (show/hide)
Grid is available only for Internet and vector maps.

Ruler (show/hide ) 

Hide POI
This option is available only for vector maps.

3D mode
This option is available only for vector maps.
Use the context menu of this button to select how to display objects on a map:
•	 Isometric projection - shows isometric projection of objects.
•	 Perspective projection- shoes perspective projections.

Elapsed time
Shows the time elapsed from the moment when the last data has been received. This 
button is active when a vehicle group or a vehicle is selected in the Device selector.

Convert route to geofence (line) - converts the route to a 
geofence of the line type. 
Width geofence - is a width of the line,  created from the route
Name - is a geofence’s name.
Swap with - changes the position of selected net and 
recalculate the route according a new sequential number of 
the net. 
Auto sorting - sorts the route points to shorten stretch of the 
route. Auto sorting is available for routes with total number 
of nets not exceeding 10.  
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STAGES
Stages viewer allows the user to divide the track into segments according to any condition. 
Conditions may be entering a geofence, power supply state, navigation signal, parking, motion, 
speeding etc.
Depending on settings, the Stages viewer can has several tabs with list of different segments on 
each of them. Columns on the tabs are configurable. The user can set default view which displays 
all available data on stages or displays preset columns by pressing the “Fixed columns” button       . 

Fig.23. Stages Viewer.

For detailed information about setting columns see extended version of the User Manual intended for 
advanced users. iNOTE

In the context menu of the Stages viewer, additional options are available.

Group stages by status - groups stages with similar parameter 
states.
Show total status rows - enables displaying of total statuses 
when stages are grouped: none, expanded or all. 
Show total row - shows total values of parameters for the 
selected time period. 
Synchronize with player - enables following the player when 
playing the track. The stage associated with the currently 
playing track point will be highlighted. 
Go to start entry - goes to the first entry or point of the 
selected stage within the Data and Maps viewers.
Go to end entry - goes to the end entry or point of the selected 
stage within the Data and Maps viewers.Fig.24. Context menu of Stages viewer.
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Copy selected rows - copies selected entries to the clipboard.
To Excel - exports list of stages to a MS Excel file.
Print - prints the list of stages out.

The context menu can be opened by right click on a stage. 

Stages viewer is synchronized with Map viewer, Data viewer and Diagram viewer. This means 
that when you select the stage in the Stages viewer (with double click), synchronized modules 
will display the information related to the selected stage - initial entry or point. For example, Data 
viewer will highlight the first entry associated with the selected stage.
Double click on a stage moves vehicle cursor to beginning of the stage. The start point of stage is 
denoted by a stage icon on vehicle track. Clicking on the icon displays additional data on the point. 

Fig.25. Click on the stage 
icon enables the hint.
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CHARTS 
Charts viewer constructs charts of different vehicle parameters related to time or distance. 

Fig.26. Charts viewer. 

To build a chart:
•	 select data to view in the Device selector;

•	 select a trip to view if the track sharing to trips is enabled;

•	 select a parameter in the Charts viewer to construct the chart.  List of parameters of the module 
consists of all vehicle parameters available in the scheme. Chart viewer automatically recognises 
a type of selected parameter and constructs a diagram, if the parameter is a switch, or a chart for 
other types. The diagram displays intervals when the switch was enabled and disabled. The chart 
is a time-parameter or distance-parameter curve. Type of relation can be selected using F(time) 
and F(distance) options on the top of the list of charts. 

•	 the user can select several parameters. When constructing, charts will overlay each other and 
diagrams will be stacked. 

•	 when pointing the mouse at the chart, the hint displays date and time of the point and the 
parameter value. 

•	 when pointing the mouse at a diagram, time span covered by the selected segment of the diagram 
will be highlighted (Fig.26).   
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REPORTS
The AutoGRAPH.NET has a built-in Reporter intended to generate various reports. 

Fig.27. Reporter. 

The window consists of several panels (Fig.27):
•	 Reports List is a list of supported reports. There are two general types: dynamic and pattern 

reports. Dynamic report is a report without a defined pattern, which consists of all available data 
on vehicle. Pattern report has a defined pattern and consists of only data sets specified by the 
pattern. 

•	 Report settings allows to specify time span and another settings of reports. 

•	 Device selector is a list of devices intended to select devices to generate reports for them. This list 
is a copy of the main Device selector. 

To run a report:
•	 select a type of report;
•	 select vehicles for reporting by checking boxes;
•	 specify settings: 
•	 specify time span for reporting;
•	 select source of data.  If data was downloaded from the server, select GSM type. If data was read via 

USB, select USB type. 
•	 enable “Share Trips” option to report information about trips. 
•	 press the “Start report” button to generate report of selected type. 
•	 after completing, the report can be printed out or saved as external file. 
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GEOFENCES
A geofence is a virtual area on a map, which will generate a notification, if an asset crosses the area. 
The AutoGRAPH.NET has a built-in Editor of checkpoints and polygons which allow to create and 
edit  geofences. 

The settings of geofences can be specified in the Geo-fences menu.  To open the menu, follow Main 
menu - “Tools” menu - Geo-fences. 

Fig.28. Geo-fences Menu.  

SETTINGS
The list of geofences can have several layers of nesting. Every geofence can have individual settings 
or take its settings from the parent group.  

To set individual settings:
•	 select a geofence;
•	 check “Individual“ boxes of required modules in the list of modules;
•	 specify settings of selected modules. 

To set settings on a group:
•	 select a group of geofences;
•	 check “Individual“ boxes of required modules for selected group and uncheck “Individual“ boxes 

for geofences in this group which must take group settings;
•	 specify settings of selected modules.
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Main image
The options on this tab allows the user to select an image for the geofence, which will denote a 
geofence on map and in the Geo-fences selector.  To specify the image select image and specify its 
hue. 

Fig.29. Main image of geofence.  

Properties registry / Property card
The Properties registry is the registry which unites properties of a geofence.  Registry of properties 
can be used to export data to external applications or to exchange data between modules within  
the AutoGRAPH.NET application. New property can be added to the registry manually or imported 
from geofences file. 
A Property card is a card of properties, intended to add user-defined properties of geofences in the 
software.  Depending on the scheme configuration, the Property card can be uninstalled.

Fig.30. Properties registry of geofence.  

Device data handler
Options of this module allows setup of parameters of geofence processing. 
•	 Check day of week - days of the week when the application will check whether geofences are 

crossed. To check or uncheck all items quickly, use “Check / uncheck” button.
•	 Fixation time - is minimum time during which the vehicle must be in / or out of the geofence to fix  

entering / or exit from the geofence. Specify the fixation time in seconds.
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Fig.31. Device data handler of geofence.  

•	 Type is the  type of the geofence. The type 
can be used for sorting geofences. 

•	 Address is the address of the geofence. If the 
address is not specified,  it will be identified 
using the installed address database. 

•	 Speed limit - minimum and maximum 
values of vehicle speed in the geofence. 

GEO-FENCE SELECTOR
Geofence selector is a module that stores list of geofences available in the scheme. 

Fig.32. Geofence selector.  

Left click on the geofence shows its position 
on a map. 
In the Map viewer the user can setup mode 
of geofence view (Fig.33).
•	 Current GF selector group - shows geofences 

of selected group. 
•	 By current vehicle settings - shows geofences 

of selected vehicle. 
•	 All - shows all geofences of Geo-fences 

selector.  
“Checkpoints and geofences” button (    )         
enables / or disables geofences displaying 
on a map at all. 

Fig.33. Checkpoints and geofences view.  
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The user can monitor passing the geofenced area by a vehicle using the Stages viewer on  the  
“Geo-fences” tab.  This tab must be enabled by the system administrator. 

Fig.34. Stages viewer. Geofences. 

The Stages viewer shows vehicle parameters into geofence and out of it. Double clicking on an item 
moves the vehicle cursor to the point associated with the first entry in the geofences and highlights 
this entry in the Data viewer.  

CREATING GEOFENCES
The AutoGRAPH.NET Software has an integrated geofence editor intended to create, edit and 
delete checkpoints and polygons. To run the  Editor, press the “Editor of checkpoints and polygons”  
button on the tool bar of the Map viewer. 

Fig.35. Editor of checkpoints and polygons.

Editor window has two tabs - “Edit” and “Create”. 
The “Create” tab is used to create a new geofence. 
The “Edit” tab is used to edit features of the created 
geofences.  Both of the tabs have similar options. 
It is possible to configure the colour and thickness 
of the contour lines of the geofence, select the 
fill colour and specify transparency. The software 
supports following types of points:  circle (Point),
polygon and line (Polyline).
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To create a point:
•	 go to the “Create” tab.
•	 specify parameters of a new point: set the colour and thickness of lines, fill colour and transparency.
•	 enter the name for the  new point in the “Name” field.
•	 select the type of the new point.
•	 use left mouse button to draw a new point on a map.

The instruction below describes how to draw each type of geofence.

Fig.36. Creating a point.

Point

1.	Place the central point on a map;
2.	Configure the radius by moving the mouse 
pointer;
3.	Right click to open the geofence context menu 
and select  “Save changes” option in this menu. 

Fig.37. Creating a line.

Polyline 

1.	Use left click to set nets of the polyline on 
a map. When drawing, the nearby points are 
automatically joined. 
2.	Before saving, it is available to move polyline’s 
vertices. Use left click to move them. 
3.	Right click to open the geofence context menu 
and select  “Save changes” option in this menu. 

Fig.38. Creating a polygon. 

Polygon

1.	Select vertex of a polygon using the left click. 
The Editor will loop nearby points automatically 
to make a polygon.
2.	Before saving, it is available to move polygon’s 
vertices.  Use left click to move them. 
3.	Right click to open the geofence context menu 
and select  “Save changes” option in this menu. 

It is possible to apply changes by pressing the Enter key. Pressing Ctrl+Z combination aborts 
changes. 
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To edit the geofence:
•	 go to the “Edit” tab;
•	 specify the geofence parameter on the tab;
•	 left clicking on the geofence opens the geofence context menu. The options of this menu are 

described below:
Save changes - saves changes. 
Abort changes -  aborts last changes.
Cut - cuts selected geofences.
Copy - copies selected geofences to the clipboard.
Paste - pastes the geofence from the clipboard.
Delete - deletes selected geofences.
Delete vertex - deletes selected vertex of the polyline 
or polygon. Use the right mouse button to select the 
necessary area on the map.
Undo last vertex - deletes the last added vertex. 
Vertex coordinates - allows changing of the coordinates of 
the selected vertex or point. 
Radius circle - allows changing of circle radius.
Subtraction polygons - subtracts  internal polygon from 
external one. To make the subtraction: 
•	 place smaller polygon in the bigger;
•	 select bigger polygon;
•	 then select smaller polygon;
•	 use left click to select a geofence. Press and hold Ctrl key 

to select several geofences. 
•	 open the geofence context menu and select “Subtraction 

polygons” option.

Fig.39. Geofence context menu. 

Convert line to polygon - converts  the selected line to a polygon. Specify conversion parameters in 
the Editor window:

Deviation - this option specifies the permissible width from the line to the polygon borders.
Quality (%)  - this option determines how accurate the  polygon should be made.  The higher the quality, the more system 
resources are required to make a polygon.
Build internal polygons - this option allows areas inside the polygons to be made.
Preview - preview of the polygon prior to building.

Convert point to polygon -  converts the selected point to a polygon. Prior to conversion, specify the 
name for a new polygon and the number of its vertices. The circle  will be converted  to a regular  
polygon with the selected number of vertices. Polygon will be created as the same dimensions as 
the circle.  You can change the layout of the vertices of the created polygon in the “Edit” tab. Select 
this polygon with a right-click and drag its vertices with a left-click.
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